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Warranty And Software Licence Agreement 

WestDev Ltd and Number One Systems 

This document contains the WESTDEV LTD SOFTWARE LICENSE AGREEMENT which will govern the use 
of the Westdev and/or Number One Systems' products supplied with it. 
You agree to the terms of this agreement by the act of opening the sealed package which contains the storage 
media on which the software is recorded. Do not open the sealed package without first reading, understanding and 
agreeing the terms and conditions of this agreement. If you do not agree to the license conditions you may return 
the SOFTWARE for a full refund before opening the sealed package.  
1. LICENSE AGREEMENT 
Ownership of the WESTDEV / NUMBER ONE SYSTEMS' Software Package and all its constituent parts 
supplied by Westdev Ltd ("LICENSED SOFTWARE") is not transferred to the Customer. Westdev Ltd hereby 
grants the Customer a non-exclusive license to use the LICENSED SOFTWARE on a single computer 
workstation. Each computer workstation, even on a network, must have its own separately LICENSED 
SOFTWARE. 
2. OWNERSHIP OF SOFTWARE 
As the LICENSEE, you own the magnetic, optical or other physical media on which the LICENSED SOFTWARE 
is originally or subsequently recorded or fixed, but an express condition of this License is that Westdev Ltd and/or 
the copyright owner retains title and ownership of the LICENSED SOFTWARE recorded on the original media 
and all subsequent copies of the SOFTWARE, regardless of the form or media in or on which the original and 
other copies may exist. This License is not a sale of the original SOFTWARE or any copy. 
3. COPY RESTRICTIONS 
This LICENSED SOFTWARE and all accompanying written materials and all other constituent parts are the 
subject of copyright. Unauthorised copying of the LICENSED SOFTWARE, including software which has been 
modified, merged, or included with other software, or of the written materials is expressly forbidden. You may be 
held legally responsible for any copyright infringement which is caused or encouraged by your failure to abide by 
the terms of the License. 
4. TRANSFER OF LICENSED SOFTWARE 
The Customer may transfer the LICENSED SOFTWARE provided that (i) this Software License Agreement is 
transferred with the LICENSED SOFTWARE, (ii) the transferee fully accepts the terms and conditions of this 
Agreement, and (iii) all complete or partial copies of the LICENSED SOFTWARE, including copies on data 
storage devices are also transferred (or destroyed). 
5. MODIFICATION 
You may not otherwise modify, alter, adapt, merge, de-compile or reverse-engineer the LICENSED SOFTWARE, 
and you may not remove or obscure any Westdev Ltd and/or Number One Systems' Copyright or Trademark 
notices. You must use all reasonable efforts to protect the LICENSED SOFTWARE, diskettes, and documentation 
from unauthorised use, reproduction, distribution or publication, or otherwise in violation of applicable law. Please 
contact our Customer Service department if you become aware of violations of Westdev Ltd's Copyright. 
6. TERMINATION 
The License is effective until terminated. You may terminate it at any time by destroying the LICENSED 
SOFTWARE and all complete or partial copies thereof. It will also terminate if you fail to comply with any term 
or condition of this Agreement. You agree upon such termination to destroy the LICENSED SOFTWARE and all 
complete or partial copies thereof. 
7. WARRANTIES 
No warranties are expressed or implied with respect to the LICENSED SOFTWARE described, its quality, 
performance, accuracy or suitability for any purpose. In no circumstances will the copyright holder be liable for 
direct, indirect, incidental or consequential damages resulting from the use of this SOFTWARE. 
8. OTHER SOFTWARE 
The supplied disks may contain software whose copyright is owned by third parties. This license agreement shall 
apply equally to this software except where the terms of this agreement are specifically modified by the copyright 
holder(s). Such modification(s) will be included in a machine readable file on the supplied disks. 
9. GOVERNING LAW 
The Governing Law of this Agreement shall be that of England. 
Westdev Ltd will reward anyone giving information leading to successful prosecution regarding breach of 
copyright. 



4   Easy-PC V14.0 Supplement 

Contents 
CONTENTS.................................................................................................................................................................4 
CHAPTER 1. GETTING STARTED ...........................................................................................................................5 

Installation ..................................................................................................................................... 5 
Data Files Location......................................................................................................................... 5 
Running Easy-PC For Windows 14.0 .............................................................................................. 5 

CHAPTER 2. NEW FEATURES IN EASY-PC V14.0................................................................................................7 
Introduction.................................................................................................................................... 7 
Projects .......................................................................................................................................... 7 
Change Component (Both).............................................................................................................. 7 
Output Reports (Both)..................................................................................................................... 8 
Add Component (Both)................................................................................................................... 9 
Cancel Move during Paste (Both)...................................................................................................10 
Design Technology and Value Names (Both)..................................................................................10 
Report Destination (Both) ..............................................................................................................11 
Grids (Both) ..................................................................................................................................12 

Multiple Grids ..........................................................................................................................12 
Change to the Grid Snap context menu ......................................................................................15 
Polar (radial) Grids ...................................................................................................................16 

Library Manager (Both) .................................................................................................................17 
Component Edit Properties (Both)..................................................................................................18 
Save To Library (Both) ..................................................................................................................18 
Save Selected Items To Library (Both) ...........................................................................................19 
‘Move To’ in Library Dialog (Both) ...............................................................................................21 
Change to Rotation Angle (Both) ...................................................................................................21 
Hierarchical Schematics (SCM) .....................................................................................................22 

Getting started with Hierarchy...................................................................................................22 
Using Hierarchy........................................................................................................................29 

Drill Ident Output (PCB)................................................................................................................34 
Dimension Text Improvements (PCB) ............................................................................................34 
View Board (PCB).........................................................................................................................35 
New Easy-Router replacement – Trace-Router (PCB) .....................................................................35 
Pull Tight Manual Routing Mode (PCB).........................................................................................37 
Pull Tight Smoother (PCB) ............................................................................................................38 
Double Click to Start Track Action (PCB) ......................................................................................39 
Design Rule Check Improvements (PCB) .......................................................................................39 
Design Revision Analyser (PCB) ...................................................................................................40 
Display of Item True Width (PCB).................................................................................................40 
Separate Tool Numbers (PCB) .......................................................................................................42 
Separate Slots Selection for NC Drill files (PCB)............................................................................42 
OrCAD Netlist ECO Import to PCB (PCB).....................................................................................43 
Micro Library 3 Update (Updated Cost Option) ..............................................................................44 
Pro Library 3 Update (Updated Cost Option) ..................................................................................44 
Connector Library 2 Update (Updated Cost Option)........................................................................44 
 

 

 



 Easy-PC V14.0 Supplement   5 

Chapter 1. Getting Started 
Installation 

Installation is via the autorun setup. If you are not familiar with this process it is 
explained briefly below: 

Insert the CD-ROM into your CD-ROM drive and wait a short time. The CD-ROM will 
run up to speed and an Easy-PC Welcome screen will appear. If autorun has been disabled 
on your computer you must execute the 'setup.exe' program using the Start menu and 
Run command from the Windows task bar. 

The installation is the same for new and existing users alike. Existing users i.e. version 
V3.0 to V13.0 can install V14.0 over an existing installation without deleting the old one 
first. 

With the installer running, once the Welcome screen is displayed, double-click on the 
Install Easy-PC For Windows - Version 14.0 option, or click then press Run. 
Following the instructions on the screen, you should use the same Destination Folder for 
the Program Files as your existing Easy-PC program files e.g. C:\Program Files\Number 
One Systems\Easy-PC 

All other instructions should be followed until completion. 

Click Finish to complete the installation. 

Data Files Location 

There is an extra step in the Setup installation wizard that asks you where you want to 
place data files (for example, libraries, technology files, etc). The default is always to use 
the common documents folder, “Users\Public\Documents\Easy-PC” on Vista and 
Windows 7, “Documents and Settings\All Users\Shared Documents” on XP etc. if you are 
installing for All Users, or into your own Documents folder if installing for current user 
only. 

Running Easy-PC For Windows 14.0 

As with all Easy-PC programs, an icon will appear in the Number One Systems folder, 
you may also wish to create an Easy-PC Shortcut icon that sits on your desktop. 

To start the program, double-click on the Easy-PC icon from the Number One Systems 
folder. 
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Chapter 2. New Features in Easy-PC V14.0 
Introduction 

All features are categorised as being SCM specific, PCB specific or Both (relevant to both 
SCM and PCB design applications). 

Projects 

For a selected Project, there are new items on the context menu, there are new entries for 
Rename and Duplicate. 

 
Rename : changes the name of the selected project item, then either creates a copy of the 
original file under the new name, or just renames the existing file. 

Duplicate : makes a copy of the selected project item under a new name. This is the same 
as copying the underlying file in Explorer and adding the new file back into the project. 

These new  items are only applicable to items under Schematic Designs in the project list. 

Change Component (Both)  

When using the Change Component option, the dialog now includes both SCM and PCB 
symbol previews of the selected component. 
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 Output Reports (Both) 

The Reports Output has been enhanced to provide extensions to the custom report 
mechanism to allow more complex reports to be generated: 

 As well as components, it can now produce a lists of nets, component pads and vias. 
This uses an existing mechanism for components and has been extended to include 
the new items. 

 Additional controls on fields are available for joining fields together, collating fields, 
and forcing newlines. 

 
Collating Columns 

When generating a parts list (Bill of Materials) the usual setup will produce one row in the 
report for each unique component + value combination. If you add the Name to the list as 
well, this would normally break the report into separate rows for every component 
instance because the component name changes for each row. By ticking the Collate 
checkbox for the Name field, this will cause the component names to be collected 
together to output as a single entry in the report: 

Component                     Value               Name                         Qty 
---------------------------------------------------------------------------------- 
10-32-1023                    6K8                 R19                            1 
10-32-1063                    68K                 R18                            1 
10uF_16V_10%_Tant_Case_C      1uF                 C93                            1 
10uF_16V_10%_Tant_Case_C      10uF                C69 C52 C6 C98 C64 C50 C52    11 
                                                  C59 C51 C49                     
12CTQ035                                          SK2 SK12                       2 
12CTQ040                                          IR1                            1 
16TTS12                       LM2940CT5           U9                             1 
---------------------------------------------------------------------------------- 

 

Joining Columns 

The Join Next Column checkbox allows you to combine adjacent fields in the report 
definition into a single column in the report. For example when producing a list of 
component pad positions, you can use this switch to combine the component name and 
pin name fields into one, by checking the Join box for the Name column and specifying a 
dot as the separator: 
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Name,Position X,Position Y 
BR1.1,15700.0000,21900.0000 
BR1.2,15700.0000,21900.0000 
BR1.3,15700.0000,21900.0000 
BR1.4,15700.0000,21900.0000 
C1.1,13750.0000,22550.0000 
C1.2,13750.0000,22550.0000 

Newline 

Although reports are generally written in a 'table' form, with columns across the report 
and one row per 'item', you can use the Newline switch to force a new line into the report 
after a particular field. This could be used for example to produce a report where each 
field is on a separate row, such as a netlist that outputs the name of the net followed by 
each pad in the net on a separate row. 

There are also new example report templates provided with the standard installation for 
writing: 

 BOM With Names 
 Pad Positions in CSV format 
 A simple Netlist format 

 

Add Component (Both) 

When placing components, when pressing Cancel, by default, the option will go back to 
the Add Component dialog. There is a new setting on the Preferences dialog under 
Interaction that controls this, unchecking the box there will cause Easy-PC to revert to its 
original action of <Esc> meaning cancelling out of the mode completely. 

 
When placing components, the Cancel option will, by default, return to the Add 
Component dialog. 
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Cancel Move during Paste (Both) 

When performing a paste of design data, you will now be able to use Cancel Move from 
the context menu to paste the item in its original position. If enabled, Online DRC will be 
performed at this position. If the original position is outside the working area an error 
message will be given and you will be able to continue moving it or Cancel the paste 
completely. 

 

Design Technology and Value Names (Both) 

Value Names in the Technology file 

Previously, it was not possible to transfer or update Value Names from a technology file 
to a design, the Technology Files (technology manager) dialog had no tab for Value 
Names. This has now been added to V14 and will work the same way as for Styles. 

 



 Easy-PC V14.0 Supplement   11 

Editing Value Names in the Technology file 

Previously, the Value Names page of Technology dialog had no means of changing the 
name of a Value, nor any ability to add, edit or delete Value Names. These have now 
been added to V14 and work the same way as for Styles. 

 

Report Destination (Both) 

Additional settings for report ‘destination’ in Preferences, allowing you to choose 
whether to write reports to the same folder as the design file (the default/original method), 
to a folder below the design file, or to a specific folder. 
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Grids (Both) 

The Grids dialog has been significantly changed to make major improvements. In 
summary, you can now add and use your own named grids each with its own display 
settings, add and use polar (radial) grids, and have your own grids displayed in the Grid 
Snap context menu. 

Multiple Grids 

You can now add and use multiple grids, these grids can also have user defined names. 
Once added, the named grids are available for use on the grid snap menu (see below). 
These grids can be used for placing items or simply used as displayable grids for 
reference. To accommodate these changes, the Grids dialog accessible from the Settings 
menu has been redesigned and improved. This dialog is divided into several sections, each 
of which is described below. 

 
Grids 

The first section of the dialog shows you a list of all the Grids currently defined in the 
design. From here you can carry out actions such as adding new grids or changing the 
name of an existing grid. Apart from adding a new grid, all other actions on this dialog 
will act upon the grid that is currently selected in this list. 

Add : add a new grid to the list. You will be prompted to supply a new name for the grid, 
which must be different from the names of any grids that exist already. 
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Rename : change the name of the selected grid. 

Copy : make a copy of the selected grid under a new name, copying across all the settings 
from the selected grid. 

Delete : remove the selected grid from the design. Note that there always needs to be at 
least one grid, so the application will not let you delete the last grid from the list. 

Make Current : sets the selected grid as the current working grid to use for placing 
items. The 'current' grid is marked in the list with an asterisk. As a shortcut to changing 
the current grid you can simply double-click on the required grid in the list. This will 
make that grid the current grid, and close the dialog. 

Grids Visible : this is a global switch that toggles the display of grids on and off. This is 
the same as using the Toggle Screen Grid toolbar button or command. Note that each 
grid also has a Visible checkbox, so that you can choose which of your grids should be 
drawn when grids are set as Visible. 

Only Draw Current Grid : when drawing grids, normally all grids which have their 
Visible checkbox ticked are drawn. By checking the Only Draw Current Grid box, you 
can choose to draw only one grid, the grid that is set as the current working grid. Using it 
this way will mean that as you flip from one grid to another, the display changes to draw 
only the grid that is current (active). 

Step 

The first box is used to define the working grid step. Type the required size in the current 
design units. 

 
Different Y : check this box to use different grid step in X and Y axes. By default, the X 
and Y steps are the same.  

Polar Grid : check this box to define a polar (radial) grid. When you check this box, 
some different settings appear on the dialog: 

 
Concentric Step : this is the distance between each 'ring' of the grid. 

Divide Circle Into : this is how many 'slices' the grid should be divided into. 
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Here you can see an example of a Polar grid, in this case divided into 8 segments: 

 
Origin 

This section of the dialog allows you to specify the origin or 'starting point' of the grid.  

 
A Polar grid will be centred at the origin position, and a normal 'step' grid will have its 
first point on the origin and step outwards from there in each direction. 

Follows Design Coordinate Origin : check this box to have the grid start from wherever 
the design System Coordinate Origin is placed.  

Origin X and Y : here you can specify a particular location for the grid origin when it is 
not following the coordinate origin. 

Snap 

Snap Mode is used to further define the grid step that is actually used in interactive 
operations such as Place. Choose a value from the drop down list as follows: 

 
If you choose a setting other than 'Grid', each step of the grid is divided according to the 
setting you select. Snap Mode is not available for Polar grids. 
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Display 

This section allows you to control how each grid is displayed. As with the other settings, 
each grid has its own display values. 

 
Visible : check this box to make this grid visible. Note that it will still only be drawn if 
the main Grids Visible checkbox is also checked. 

Draw Grid First : check this box to draw the grid before drawing actual design items. 
This has the effect of drawing the grid 'underneath' everything else. 

Primary Colour is used for every 10th grid point of a step grid, or for the radial 'arms' of 
a Polar grid. Check the Lines box to have the grid drawn as lines, otherwise it is drawn as 
dots 

Secondary Colour is used for all other grid step points. As you use Unzoom to increase 
the amount of the design that is displayed you will reach a level where the secondary grid 
points are too close together and they will no longer be displayed. The same is true for the 
Primary points for a step grid if you carry on with zoom out. 

For a Polar grid, if you uncheck Primary Lines, the grid is drawn with a single dot at 
each place where the rings and the radial arms intersect. 

Change to the Grid Snap context menu 

There are additions to ‘grid snap menu’ allowing you to choose current grid, and access 
Grids dialog. These can be changed interactively when editing or placing items in the 
design. The default shortcut for this is the <H> key. A small menu will be displayed 
which allows you to select the Snap Mode (for a step grid), to change the current working 
grid to a different grid (if more than one grid is defined), or to access the Grids dialog. 
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Polar (radial) Grids 

Once a Polar (radial) grid has been defined in the Grid dialog (like the one shown below), 
you can then place components on this grid using interactive placement options. 

 
With the Polar grid active, you can use this during placement by selecting your Polar grid 
from the context menu and Grids>.  The grid selected must be a polar grid as defined in 
the Step option of the Grids dialog. 
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Once this grid has been selected, you can then access the Auto-rotate option from the 
context menu. This will allow components to be rotated on-grid to a grid rotation with an 
accuracy of a 1/100th of a degree. 

 
The auto-rotate settings can be predefined from the Preferences menu and PCB 
Interaction. 

 
From this option, you can select which items the auto-rotate feature applies to by 
checking the box next to the option. 

Library Manager (Both) 

When using the Library Manager to copy or move a multiple selection, the Save To 
Library dialog now provides two additional buttons;  OK All and Cancel All, which act 
on the selection as a whole. 
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Component Edit Properties (Both) 

Values Dialog 

The Values dialog in the Component editor has been changed so that it is now a page on 
the Properties dialog, this will save time swapping between the packages to get to the 
Values fields. 

 
Replication of Values to all Packages 

There are two new controls on the Values page to handle replication of Values to all 
packages in the component. The first is a button that causes any new Value added to be 
added to existing packages (the All Packages button). The second is a check box (New 
Value added are added to all other Packages) at the bottom of the dialog. When ticked 
causes any new Value added to be added to all packages within that Component. 

 

Save To Library (Both) 

When using Save To Library (components or symbols) from the File menu, you can now 
select the special entry [New Library] from the drop down list of library files. This 
allows you to create a new library file to save the item into. 
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A Save As dialog is displayed, into which you type the new library name. 

 
If the library path is a folder currently not in the list of libraries folder, Easy-PC will ask if 
you would like to add it. By adding it, it will then be included in the library search used 
when using the Add Component option etc. 

 

Save Selected Items To Library (Both) 

This option allows you to easily copy sets of components and/or symbols to library files. 
It can be used from the Components page of the Library dialog to make a self-contained 
copy of selected library items. For example if you want to make changes to items in our 
master libraries it is best to copy them to your own 'user' libraries first, to avoid any issues 
with overwriting your changes if our master libraries are upgraded in the future. 

It can also be used to make a set of libraries containing some or all of the components and 
symbols in a PCB or Schematic design file. This can be useful for example if you have an 
archived design for which the libraries are no longer available or if you wish to create a 
project based library. A complete set of the three types of libraries can be created in one 
single step. 

Copying Items In Library Manager 

From the Components page of the Library Manager dialog, select the component or 
components you wish to copy, then click the Save To Lib button. 
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Copying Items From A Design 

To copy library items out of a PCB or Schematic design, simply select the component or 
components you wish to copy to the library, then right-click and choose Save To Library 
from the context menu. 

 
Using the dialog 

The top part of the dialog shows the three types of library, and a dropdown list where you 
can choose the target library to which the relevant library items should be written. The 
checkbox alongside each of the library types controls whether or not that type of library 
item will be written. In the dropdown list of libraries, there is also an entry [New Library] 
which if selected will prompt you to create a new library before copying starts. 

 
Underneath this are three lists, one for each type of library item. In the Components list 
will be shown all the components that were selected in the design or on the Library 
Manager dialog, depending on where you started from. The PCB and SCM symbol lists 
will show all the symbols that are referenced by the components. If you are saving from a 
design file, only one of the two symbol lists will be filled as a design only contains one 
type of symbol. 

Selecting items in the lists 

If you click on any of the components in the left-hand list, the PCB and Schematic 
symbols which are referenced by the components you have selected will be shown 
selected. Conversely, clicking on any of the symbols will show you all the components 
that reference that symbol. 
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This feature can be used to 'explore' the relationship between the components and symbols 
you are going to save. This will not affect what is actually written to the target libraries, 
that is only controlled by the checkboxes at the top.  

Starting the copy 

To initiate the actual copying, click the OK button. If you choose to write to a new library 
for any or all of the library item types, you will be prompted to specify a folder and 
filename for the new library. 

If the target libraries already exist, then they will be checked to see if any of the items to 
be copied already exist, and you will be given the choice of overwriting the existing 
items, skipping those that exist, or cancelling the whole copy operation. 

‘Move To’ in Library Dialog (Both) 

There is a new button in Library Manager dialog Move To. This does same as Copy To 
but deletes the items from the source library afterwards. When run, a confirmation dialog 
is displayed to warn you about the deletion afterwards. 

 
Pressing the Move To button gives you the Save To Library dialog. 

 

Change to Rotation Angle (Both) 

Angular resolution (precision) has increased from 1 to 2. This means items like 
components can now be placed to an accuracy of 0.01 degree (1/100th degree). When 
using this precision, care must be taken to ensure your later processes, like assembly 
machines, can handle it. 
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Hierarchical Schematics (SCM) 

Getting started with Hierarchy 

Version 14 introduces the ability to add multiple hierarchical schematic sheets to a 
project. From within a Project file, you can now have multiple sheets and blocks, these 
blocks link to lower level circuitry. 

To use hierarchy, the designs must be contained within a Project file. 

 
Hierarchical Building Blocks 

The diagram above illustrates how various scenarios are possible when using hierarchy, 
all within the same Project file. A design sheet can contain multiple blocks (2) and 
multiple hierarchical sheets. In (3) an existing block can be copied and effectively used 
again, it is renamed though. Schematic (4) shows multiple blocks and a block inside a 
block (a nested block). 
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Overview 

Schematic design sheets in a project can have a hierarchical structure. This is different to 
using multiple sheets in a project at the same level in that you can add a block on a 
schematic sheet and push into that block to reveal the block contents on another schematic 
design. For example, this could be detail that can be covered by an overview block, say 
PSU or MEMORY etc. but for which you can show the lower level detail on a separate 
sheet. To use hierarchy, the designs must be contained within a Project file. 

 
The above shows a top level schematic design with two blocks. Under this, each block’s 
contents is a separate schematic design within the Project. 

There are two reasons for using a hierarchical schematic design structure.  

 To allow a schematic design to be structured, so that it can be broken down into it's 
functional elements. This promotes "Top Down" design; break down a problem into 
functional elements, then define the detail of each element.  

 To facilitate the re-use of commonly used circuit elements. This promotes "Bottom 
Up" design; use predefined elements to build a solution.  

In practice, you may want to use a combination of both "Top Down" and "Bottom Up" 
design.  

What is a block? 

In Easy-PC a block consists of two parts. The first part is a block symbol, inserted into a 
schematic design to represent the block at the higher level. The second part is a complete 
schematic design containing the design elements that define the contents of the block, and 
this represents the implementation of the block at the lower level.  

The two halves of the block can be defined separately, but are eventually linked within a 
project by using a common block name. The block symbol has a name, and a schematic 
design representing a blocks contents can be allocated a name using the Design 
Properties dialog.  

The block symbol can contain block pins that can have schematic connections attached to 
them to pass signals to a corresponding block port in the blocks contents design. The 
block ports are single pin symbols that can be separately placed anywhere in the lower 
level design.  
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The link between a block symbol pin and its corresponding block port is set by both 
having the same port name.  

Blocks are not copied to the PCB design, but exist to place a hierarchical structure on the 
schematic representation of the design. When translating the schematic into a PCB design 
a check will be made to ensure each block symbol pin and its corresponding block port 
are on the same net.  

A hierarchical design is easier to navigate, because you can Push into the design 
representing the block contents, from it's block symbol, and Pop out of the block design, 
back to the block symbol.  

In a project tree view, schematic designs that represent the contents of blocks will have a 
blue icon and display their block name. If their block symbol is also defined, they are 
shown as an indented branch below the design that contains the block symbol. This way 
the hierarchical structure of the design is clearly shown.  

Adding Blocks 

There are three ways of adding a block into a design.  

1. Add Block 
Use this option from the Add menu to insert a new block into the design. A 
dialog will be displayed for you to define the block name, set the number of 
block ports, choose the block symbol and supply the name of the block contents 
design. 
Define what the block symbol will look like by either using a schematic symbol 
from the library, or generating a standard rectangular shape using user specified 
parameters. 
The block contents design can be a new design or you can hook up to an 
existing design either already in the project or a design file in the project folder.  
The block symbol can be placed in the current design and the block design will 
be automatically added to the current project. Block ports will not be initially 
added to a new block design, but you can add them when editing the design by 
using Add Block Port when the port is needed.  
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2. Cut To Block 
Use this if you want to take an existing schematic design and cut a section of it 
into a block. This option prompts you to draw an outline around the items to be 
pushed into a block, and across any connections that are to be passed down into 
the block. The connections are cut at the outline and terminated on a block 
symbol pin. The other half is pushed to the new block design and terminated on 
a corresponding block port.  
The drawn outline and new block pins become the block symbol, and all data 
within it is moved into the new block design. The block symbol can now be 
replaced with a more suitable shaped symbol using the Change Block Symbol 
option.  
The new block design will take a default file name based on a name stem 
defined with the Block Defaults dialog. You can change this name in the 
project view by selecting the schematic design and using the Rename option 
from the context menu.  

3. Duplicate Block  
Once you have added a block using one of the two methods above, you can 
create multiple copies of it using the Duplicate command. This will allow you 
to copy the block symbol and the designs that it uses to define its block 
contents.  
All component and block names used in the original block will be incremented 
in the duplicated block designs. User named nets will be merged with the 
original nets if they are used at a higher level outside of the cut block, or will 
become new nets with incremented names if they are used just within the cut 
block.  

Navigating A Hierarchical Design 

To navigate the hierarchy of a project, you can either use the project view to switch to the 
design representing a block, or you can use the Push and Pop commands within a design.  

To Push into a block, select any part of the block symbol and use the Push Into Block 
command from the context menu. The blocks design will be opened and if you had 
selected a block symbol pin the corresponding block port will be selected. You can use 
double-click on the block symbol outline, or on a connected block symbol pin to quickly 
perform the same operation.  

To Pop out of a block contents design, back to its block symbol, select the Pop Out Of 
Block option from the context menu. You do not need to select anything in the block 
design to do this, but if you select a block port the corresponding block symbol pin will be 
selected instead of the whole block symbol. You can use double-click on the block port 
outline to quickly perform the same operation.  

Hierarchical Nets 

The span of nets in a project containing blocks is no different to a project with separate 
schematic sheets in it. If the net in a block design has a user defined name, it may also be 
used anywhere in the entire design. So the user named net can be used inside and outside 
of a block, and all items on the net in both designs will be connected together when a PCB 
design is created. Therefore all user defined net names are always global in a project. 
Auto named nets are only unique within a single schematic sheet, and so these cannot be 
used to connect from a block symbol pin in one design to its corresponding block port in 
another design, as they would end up as different nets in the PCB design.  

Each block symbol pin and its corresponding block port must therefore be on the same 
user defined net. If two different named nets are used, an error will be given when running 
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the hierarchy report, or when attempting to create a PCB design or adding forward design 
changes to a PCB design.  

To help keep these nets the same, when you start a new connection from a block port, its 
corresponding block symbol pin from the higher level design will be accessed to retrieve 
the name of the net attached to it. This net will then be automatically used for the new 
connection. Thereafter, though, the nets will not be kept in line automatically, but can be 
checked at any stage using Design Rule Check or the Hierarchy Check Report.  

 
Creating Commonly Used Blocks 

You may want to create a set of separate schematic designs representing commonly used 
blocks, such as power supplies or signal converters. These designs can contain block ports 
to terminate signals to be passed in and out of the block. It is then possible to copy these 
existing block designs into a project and link them to block symbols added to a higher 
level design in the project. This is done by using Design Properties (View menu, 
Properties with nothing selected in the design) to change the block name for the design. 
The block port names will have to be resolved at this stage to ensure the correct ports are 
linked to their corresponding block symbol pins.  

 
Editing Block Symbols 

Blocks and block ports resemble schematic symbols, but are implemented as an internal 
"group" of shapes, text and pins representing the symbol. This enables them to be easily 
altered within the design, for example to have extra pins, a wider box, or descriptive text 
added. You can use Edit Block Symbol on a selected block symbol or block port symbol 
to open a new window to edit its contents, add shapes, pins and text etc. After edit, use 
Save to replace it in the design and it will again act like a single item. Edit Block Symbol 
is available on the context menu for a selected block outline. 

When adding block symbols or block ports to a design, you can choose to auto generate 
them using some simple parameters, or use a schematic symbol from a library. The 
symbol from the library itself will not be used, but a copy of its elements will from the 
block symbol or port. This enables you to predefine standard block and block port 
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symbols in your libraries to ensure a consistent interface. For example you could define 
separate input and output block port symbols.  

 
A block port created from a library symbol will remember its symbol name and can be 
replaced by a changed symbol from the library at a later stage using the Change Block 
Symbol function from the context menu, this is available for a selected block outline. 

 
You can set up a highlight colour to force all Block Symbols and Block Ports to be the 
same colour, thus differentiating them from components in the design. Block symbols can 
also be individually changed to have their own colour using the Properties dialog.  

Adding A New Connection To A Block 

If you have a new signal that you wish to physically take down to an existing block 
design, you can start or end the connection directly on a block symbol outline. A new 
block symbol pin will be added to the outline to terminate the connection on, taking an 
automatically generated port name. You can then double click on the block symbol to 
push down into the block design and use Add Block Port to add the port, from which you 
can start a connection to continue the signal in the block design. The net will be 
automatically set to the net used in the upper level.  
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Checking The Hierarchy 

You can use the Design Rule Check option to check the consistency of the two halves of 
each block in a design or project. An error marker will be placed on a block symbol pin if 
it has no corresponding block port, or if its block port is connected to a different net.  

 
Alternatively, if you don't want to produce error markers, you can run the Hierarchy 
Check Report from the Reports dialog to get a report of any problems in the hierarchy. 
You can run this report on the whole project (from the project view), on a specific 
schematic design, or just on the selected block symbols from the context menu.  

Hierarchical problems can be serious and difficult to fix once the PCB design has been 
created, so the Translate To PCB, Integrity Check and Forward Design Changes 
options will run the Hierarchy Checker prior to their operations and will not continue if 
there are problems.  

Finding Blocks 

You can use the Goto Bar to find any block symbols and block ports in the entire 
project.  

   
Deleting Blocks 

When block symbols are included in a selection that is being deleted you will be asked if 
you want to delete entire hierarchical blocks by removing all of their block designs from 
the project. At this stage you can also decide to just delete the block symbols and leave 
the block designs in the project. These designs can be re-introduced into the hierarchy at a 
later stage by linking by name to free block symbols, or can be deleted from the project 
using the project view.  

Removal of entire blocks, including their contents, with the Delete option does not delete 
the actual design files from disk. The files can be restored to the project at a later stage or 
moved to another folder to be used in a different project.  
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Block Default Settings 

The Defaults dialog has sections for setting the parameters that define what a generated 
Block Symbol and Block Port will look like. Here you can also set up the default name 
stems for block names, block design names, port names and default block net names. 

 

Using Hierarchy 

Starting with Top Down Design 

 To create a top-down hierarchical design 

1. Start with an open schematic from within a Project file. 

2. We will first use a new block with no circuitry, we will assume the circuit will be 
added afterwards. 

3. Select Add Block from the Add menu. 
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4. The dialog is split into three sections; Block Name and Description, Block Details 
for the block ‘outline’ and the number of ‘ports’, and the bottom box containing the 
block schematic contents. 

5. For Block Name: this identifies the block. It can be a system allocated name, like 
B1, or a user defined name, like MEMORY. A name to reference the actual contents 
of the block would be more useful. 

6. For Block Details: we will select Auto-Generate. Once you have established some 
block shapes, you can save these to the library and reuse them using the From 
Library: option. The definition of the auto-generated block shape can altered by 
selecting the Specify box. A dialog will allow you to create the auto-generated block 
using your own criteria. 

7. For this example, make the Number of Block Ports: 4 

8. We will create a new schematic design for the Block Contents. 

9. Select the Generate New Schematic Design: radio button. 

10. A default name is entered for you (Block1), change this to be more meaningful, 
we’ve typed Memory. This will be the new name for your lower level schematic 
design. It also matches the Block name but this isn’t essential. 

11. Click the Add button. This will add your new block symbol to the current design. 
Don’t forget, it will also add you a new lower level schematic design named 
Memory. 

 
12. Once added, the Add Block dialog is displayed again to allow you to add another. 

13. Click the Cancel button on the dialog to close it, we only need one block. 

14. In the design, double-click on the block outline to push down into it. You could also 
select the outline and then select Push Into Block from the context menu. If you 
have a shortcut key allocated to this option, selecting the block and pressing the 
shortcut key is also a quick way to push into the block. 

15. You’ll notice the design name appears on a workbook tab at the bottom of the design 
area, if the Tabbed Designs option is enabled on the Views menu: 

 
16. The lower level schematic will now come to the front and be editable. 

You now need to add corresponding Block Ports (pins) to the schematic. 
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 To add Block Ports to the lower level schematic 

1. From the Add menu, select Add Block Port. 

 
2. A list of Port Names: is shown in a drop down list. This will be a list relating to the 

number of block ports shown on the top level block symbol. 

3. You’ll see that the list contains the same number of Block Ports plus one extra, 
shown as <New>. The list knows how many should be added to match the top level 
block. 

 
4. The Block Port Appearance is the shape of the block port itself. This can be a symbol 

from the symbol library or an Auto-Generated one. 

5. If using an Auto-Generated symbol, the Port Style and Port Outline can be 
defined using the Specify button and dialog box. 

6. For now, we will keep things simple and leave the default Auto-Generated values. 

7. Press the Add button to add a block port to the design. 

 
8. Each block port is added to the design in sequence. Once one port has been released, 

you are returned to the Add Block Port dialog to add the next. 
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9. When the option gets to the first new port (the one marked as e <New> in our 
example, and the fifth port to be added, a warning dialog is displayed to inform you 
that there is a mismatch in numbers of ports between the top and lower levels. 

10. Press the Cancel button to close the dialog. 

11. Your block is complete with both upper and lower levels. 

Cutting your design to block 

If you have an existing non-hierarchical design, you may wish to divide the design into 
blocks. The Cut To Block command allows you to select a piece of circuitry and create a 
block from it. Cutting a piece of circuitry to a block does not change the connectivity of 
the design.  

 To cut a design to block 

1. Select the Cut To Block option from the Edit menu.  

 
2. Draw around the circuitry you wish to cut into a block. By default, this is a 

rectangular frame, you can also use a polygon by selecting Polygon Select from the 
context menu. 

 
3. Once the selection is completed, a block is created which contains all the items that 

were fully selected. 
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4. Each of the connections and busses are cut at the point they cross the selection shape. 
Connections are terminated on the upper level at a block symbol pin, and on the 
lower level by a block port.  

 
5. If a cut connection does not have a user defined net name, its net is changed to a 

name generated using the name stem taken from the block defaults.  

6. The block symbol outline on the upper level is created using the selection shape. The 
symbol line style and block pin style for this symbol are taken from the Block 
Defaults. 

7. You can later edit this block symbol shape using Edit Block Symbol from the 
context menu, or generate a standard box shape, or use an existing schematic symbol, 
by using the Change Block Symbol option from the context menu. 

8. Pushing into the block by double clicking on its outline will reveal all the items 
removed from the upper level. 

 
9. Connections which were cut will end on corresponding Block Ports.  
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Drill Ident Output (PCB) 

You can now choose to output plated/unplated, round or slotted drills separately on the 
drill ident (drill drawing) output in the Plotting & Printing option. 

 

Dimension Text Improvements (PCB) 

There are many small changes to the Dimension option to improve its use: 

Alignment of Dimension Text with the Dimension 

Dimension text can now be defined as Horizontal, Vertical or In-Line with the dimension, 
previously they were always Horizontal.  

This can be predefined in the Defaults dialog on the Settings menu. 

 
Use this to set the direction of the text item for new dimensions. Choose between having 
the text Horizontal, Vertical or In Line with the dimension arrow lines. You can set the 
default separately for Orthogonal dimensions and Free Angle dimensions. 
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These settings are also available for individual dimensions by using Properties. 

Optionally showing the Dimension Text Units 

Dimension text can now optionally show the units, previously, it always showed the units.  

 
With the Show Units In Text box selected, it will either show the current units or your 
own Units Text: With it not selected, just the dimension value will be shown. 

Using the Default Text Position 

You can now select a dimension and toggle Use Default Text Position from the context 
menu to change the dimension text from always being put in its default position. If 
switched off, you can move the text to any position without having to ‘explode’ the 
dimension. 

Setting up defaults for Dimensions and Properties page 

The Dimension text position and text units can be set as Defaults, and all new features 
can also be changed on individual dimensions using the Properties dialog for selected 
Dimensions. 

View Board (PCB) 

There is a new option on the View menu for zooming into the board outline. Whereas 
View All will zoom to the maximum extents of all items in the design, the View board 
option will only zoom to the board outline. It will ignore all other design items outside the 
board. 

New Easy-Router replacement – Trace-Router (PCB) 

The Easy-Router product has been replaced with the new Trace-Router autorouter from 
Number One Systems. This will be a direct replacement and will require a new auth-code 
to license it. It is licensed the same as all cost options using the Settings menu and 
Optional Features. 
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This router has been developed to combat the ever increasing rise in fine pitched devices 
available today. 

The Trace-Router is available on the Tools menu and when selected the following dialog 
is displayed: 

 
Routing Passes 

Routing This invokes a number of routing passes which will route either all nets in the 
design or the specified nets, depending on which option started this dialog. You can 
specify the number of passes that you want. The more your design the larger number of 
passes that you will want to give it. If it routes to 100% before the number of specified 
passes then no more passes will be attempted.  

Optimising This invokes re-routing passes which attempt to reduce the overall track 
length and via count once the Routing passes are complete. You can specify the number 
of passes that you want.  

Fanout This invokes a number of passes that routes short escape tracks to vias from SMD 
pads. This is done before the Routing passes. Fanout passes are not necessary in order for 
the router to function, and is more useful as a initial phase before manual routing. You can 
specify the number of passes that you want.  

Any of the above pass options can be disabled by unchecking the appropriate box. You 
can also specify Unlimited passes, in which case, the router will continue until the board 
is complete, or until it is cancelled. 

Tracks 

Use Minimum Width means that if a net has a net class defined the router will use the 
minimum track style as opposed to the nominal track style.  

Keep Preroutes means that existing routing is protected against being ripped up by the 
autorouter.  

Keep Fixed means that only routes that are already fixed will be protected against being 
ripped up by the autorouter.  
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Fix New means that tracks routed by the autorouter will become fixed and will remain 
unaffected by the autorouter if a subsequent routing pass is made, changing the route 
parameters.  

Check Load Results After Each Pass if you want the display refreshed with the latest 
results after each pass.  

Check Display Report On Completion if you want the Auto Router to produce and 
display a status report when it finishes. 

Costs will invoke the Costs option which can change the Cost Factors used by the Auto 
Router. You can use this dialog to change the costs involved with Ripping up existing 
tracks and inserting vias. You can also restart the Router at a specified Pass.  

Default Costs changes the costs back to their default values.  

The Route option will start the Auto Router using the values specified in this dialog. 
Close will exit this dialog without starting the Auto Router but will store any changed 
values. 

Pull Tight Manual Routing Mode (PCB) 

A new Pull Tight Track mode to complement the new router is available on the Add 
menu. This works slightly different to the conventional manual routing and sketch track 
modes. Two things make is different; the track is ‘pulled tight’ between the source and 
target pads. Think of it as a piece of string if you like, being pulled tight around some 
obstacles. This is what the appearance of the completed track would look like, the shortest 
track length but pulled close to obstacles.  
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The second is the introduction of an auto-finish concept (switchable). When the track gets 
close enough to the target pad, it will auto-finish, ready to start editing the next 
connection. 

 
On the Settings menu and Preferences, PCB Tracks tab, you can now decide how the 
double-click on a connection action will behave for Pull Tight mode.  

 

Pull Tight Smoother (PCB) 

To complement the new Pull Tight mode, version 14 introduces the new Pull Tight 
Smoothing mode, this is available on the Tools menu under Smooth Tracks. 

 
To demonstrate the effects of running the Pull Tight Smoother, the picture below shows 
the track path before smoothing: 
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And after Pull tight Smoothing. You can clearly see that the track path now ‘hugs’ the 
obstacle to ensure the track is pulled as tight as it can be between the source and target 
pads. 

 

Double Click to Start Track Action (PCB) 

On the Settings menu and Preferences, PCB Tracks, you can now decide how the 
double-click on a connection action will behave. You can choose between Add Track, 
Pull Tight and Sketch modes. 

 

Design Rule Check Improvements (PCB) 

Copper Shape Verification 

An additional check Copper Shape Verification has been added to Manufacturing. This 
examines the shapes that would be generated during Gerber hardware fill and verifies that 
they won’t break out or foul other items. 
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Design Revision Analyser (PCB) 

When using the Design Revision Analyser from the Tools menu, it now checks for 
changes in Testland state on pads and vias. If you have added or removed the Testland 
status of a pad or via, it will be reported. 

Display of Item True Width (PCB) 

To aid the de-cluttering of PCB designs, Easy-PC 14 introduces the ability in Display to 
switch on and off the true width of individual items. When switched off, the item is shown 
as a centreline object. The exception to this are pads and vias which are displayed as their 
outer edge (as an outline) and the pad diameter inside. 

From the View menu, this feature is available in Display. You will see two extra fields 
next to Display and Selected called True Width. You can switch the true width of items 
on and off in columns for each layer or in rows for each item. So for example, you could 
switch the true width off of all items on the top layer to make the lower layers more 
prominent. Likewise, you could switch the true width off of all pads in the design, making 
the tracks more prominent while routing. 

 
Below are illustrations showing a small PCB design with various combinations of the 
True Width mode enabled and disabled. 

 

 

 

A PCB showing the ‘normal’ state 
where all widths are shown as true 
thickness. 
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This PCB is shown with tracks 
with true width set to off. 

 

 

 

 

This PCB shows both tracks and 
pads shown with their true width 
off. 

 

 

 

 

This PCB shows all items with 
their true width off. 

 



42   Easy-PC V14.0 Supplement  

Separate Tool Numbers (PCB) 

Within the Plotting & Printing option. there is a new check box on Setup NC Drill 
(Excellon) dialog; Separate Tool Numbers across Drill files in one run.  

This option allows you to force tool numbers to be unique across all the drill files 
generated in one 'run'. So if you have several layer spans and some plated and unplated 
holes, and are outputting all those different types of hole to different drill files, checking 
this box will ensure that the tool numbers in each file follow on from each other. With this 
box unchecked, or for files produced in separate runs, the tool numbering will start from 1 
in each drill file. 

 

Separate Slots Selection for NC Drill files (PCB) 

In the Plotting & Printing dialog, you are now able to select Slots as a new Hole Type 
output for NC Drill and plotting options, for Drill Drawings for example. 
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OrCAD Netlist ECO Import to PCB (PCB) 

After running Import and using an OrCAD netlist, you can now use the ECO From 
Netlist option from the File menu to import the updated netlist file. This would be an 
updated netlist file generated from OrCAD. It is not an ECO file or such like. 

When the ECO from Netlist option is run, it requests the name of the ECO file. 

 
The net list is read and passed through a comparer to check for differences. The Forward 
Design Changes dialog is displayed: 

 
If changes are found, a confirmation dialog is displayed: 

 
Once the changes have been made, a report is shown with the changes made: 

Added net "ECO_NET". 
Connected pin "U2.12" to net "ECO_NET". 
Connected pin "U1.4" to net "ECO_NET". 
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Micro Library 3 Update (Updated Cost Option) 

Note: for all updated library contents, the exact quantity may change slightly from the 
numbers below. 

An additional 750 new micro controllers have been added to the existing Micro-controller 
library from the Altera SX range. If you have purchased this library already, we will 
supply this update to you free-of-charge when you buy Easy-PC 14. If you decide you 
would like the update without buying V14, there is a small upgrade charge. 

A full list is supplied online in the Micro-Controller datasheet. 
www.numberone.com/downloads/datasheets/MicroLibraryUpdate.pdf  

Pro Library 3 Update (Updated Cost Option) 

The Pro-Library has been significantly updated to include over 20,000 additional Parts 
and their associated Symbols and Footprints. This takes the Pro-Library from 29,000 to 
just under 50,000 Parts! This is the second update with an increase of over 50% for you to 
use instantly.  Components have been added for Altera, LT, Maxim, Microchip, National 
and Xilinx. This upgrade is supplied free of charge when you upgrade to version 14 or as 
a chargeable option if you decide not to upgrade to version 14. 

A full list is supplied online in the Pro-Library datasheet. 
www.numberone.com/downloads/datasheets/ProLibraryUpdate.pdf 

Connector Library 2 Update (Updated Cost Option) 

With it's second update, another 210 components have been added to the connector library 
giving you a total of over 22,710. These are ready to use and to simply drop into your 
design. New connectors are included for the Hirose library. This upgrade is supplied free 
of charge when you upgrade to version 14 or as a chargeable option if you decide not to 
upgrade to version 14. 

A full list is supplied online in the Connector Library datasheet. 
www.numberone.com/downloads/datasheets/ConnectorLibraryUpdate.pdf 

 

www.numberone.com/downloads/datasheets/MicroLibraryUpdate.pdf
www.numberone.com/downloads/datasheets/ProLibraryUpdate.pdf
www.numberone.com/downloads/datasheets/ConnectorLibraryUpdate.pdf

